;{E NESAS Application Note

Renesas RA Family

High Performance with RA8 MCU using Arm® Cortex-
M85 core with Helium™

Introduction

This application note describes the creation of applications with improved performance with Renesas RA8
MCUs using Cortex-M85 (CM85) core with Helium™. It is intended to highlight the performance advantages
of the Arm® Cortex-M85 core, including low latency operation. Helium, Arm’s M-Profile vector extension with
integer and floating-point support enables advanced Digital Signal Processing (DSP), Machine Learning (ML)
capabilities and helps accelerate compute-intensive applications such as endpoint Atrtificial Intelligence (Al),
ML.

This application note walks you through all the steps necessary to achieve higher performance, including:

e Application overview

e Application highlights

e Tool configuration

e Application confirmation

Required Resources
Development Tools and Software

¢ |AR Embedded Workbench (IAR EWARM) version 9.40.1.63915 or later
¢ Renesas Flexible Software Package (FSP) v5.0.0 or later.

Hardware
e Renesas EK-RA8M1 kit (RA8M1 MCU Group)

Reference Manuals

¢ RA Flexible Software Package Documentation Release v5.0.0
¢ Renesas RA8M1 Group User’'s Manual Rev.1.0
e EK-RA8M1-v1.0 Schematics
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1. Application Overview

The application projects accompanying this document showcase the performance advantages of the
Renesas RA8 MCU with CM85 core. Helium intrinsics and Arm® CMSIS DSP Library functions are
benchmarked to highlight the improvements versus the scalar version of these intrinsics.

The applications also utilize Tightly Coupled Memory (TCM) and cache together with Helium for further
performance improvement.

2. Arm® Cortex®-M85 Core and Helium™ Technology

Arm® Helium™ technology is the M-profile Vector Extension (MVE) for the Arm Cortex-M processor series. It
is part of the Arm v8.1-M architecture and enables developers to realize a performance uplift for DSP and ML
applications. Helium™ technology provides optimized performance using Single Instruction Multiple Data
(SIMD) to perform the same operation simultaneously on multiple data. There are two variants of MVE, the
integer and floating-point variant:

e MVE-I operates on 32-bit, 16-bit, and 8-bit data types, including Q7, Q15, and Q31.
o MVE-F operates on half-precision and single-precision floating-point values.

MVE operations are divided orthogonally in two ways, lanes, and beats.

e Lanes

Lane is a portion of a vector register or operation. The data that is put into a lane is referred to as an
element. Multiple lanes can be executed per beat. There are four beats per vector instruction. The
permitted lane widths, and lane operations per beat, are:

— For a 64-bit lane size, a beat performs half of the lane operation.

— For a 32-bit lane size, a beat performs a one lane operation.

— For a 16-bit lane size, a beat performs a two-lane operation.

— For an 8-bit lane size, a beat performs four lane operations.

e Beats

Beat is a quarter of an MVE vector operation. Because the vector length is 128 bits, one beat of a vector
add instruction equates to computing 32 bits of result data. This is independent of lane width. For
example, if a lane width is 8 bits, then a single beat of a vector add instruction would perform four 8-bit
additions. The number of beats for each tick describes how much of the architectural state is updated for
each architecture tick in the common case. Systems are classified by:

— In a single-beat system, one beat might occur for each tick.

— In a dual-beat system, two beats might occur for each tick.

— In a quad-beat system, four beats might occur for each tick.

Cortex®-M85 implements a dual-beat system, and it supports overlapping up to two beat-wise MVE
instructions at any time so that an MVE instruction can be issued after another MVE instruction without
additional stall . Refer to Arm® Cortex®-M85 Processor Devices for more information.

2.1 Arm® Cortex®-M85 core
Main features of Arm® Cortex®-M85 core in Renesas RA8 MCU are as follows.

e Maximum operating frequency: up to 480 MHz
e Arm® Cortex®-M85 core
— Revision: (rOp2-00rel0)
— Armv8.1-M architecture profile
— Armv8-M Security Extension
— Floating Point Unit (FPU) compliant with the ANSI/IEEE Std 754-2008
Scalar half, single, and double-precision floating-point operation
— M-profile Vector Extension (MVE)
Integer, half-precision, and single-precision floating-point MVE (MVE-F)
— — Helium™ technology is M-profile Vector Extension (MVE)
e Arm® Memory Protection Unit (Arm MPU)
— — Protected Memory System Architecture (PMSAvS8)
— — Secure MPU (MPU_S): 8 regions
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— — Non-secure MPU (MPU_NS): 8 regions
e SysTick timer
— — Embeds two Systick timers: Secure instance (SysTick_S) and Non-secure instance (SysTick_NS)
— — Driven by CPUCLK or SYSTICKCLK (MOCOQO/8).
e CoreSight™ ETM-M85

Figure 1 shows the block diagram of Arm® Cortex®-M85 core.
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Figure 1. Cortex®-M85 Core Block Diagram
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2.2 Renesas RA8 MCU

The RA8M1 MCU group incorporates a high-performance Arm® Cortex®-M85 core as shown in the previous
section with Helium™ running up to 480 MHz with the following features.

e Up to 2 MB code flash memory

¢ 1 MB SRAM (128 KB of TCM RAM, 896 KB of user SRAM)

o QOctal Serial Peripheral Interface (OSPI)

e Ethernet MAC Controller (ETHERC), USBFS, USBHS, SD/MMC Host Interface
¢ Analog peripherals

e Security and safety features.

Memaory Bus Arm@ Cortex®-M85 System
2 MB code flash External Dsp FPU PORPVD Clocks
- CsC MOSCISOSC
12 KB data flash DAL
Reset
SDRAM HIMIL) OCO
1 MB SRAM - (ML)
MPL
1 KB Standhby = Mode control PLL1/PLL2
SRAM
NVIC
Power control CAC
DMA System timer
ICuU Battery backup
DTC
Test and DBG interface
Register write
DMAC = 8 prgtecﬂgn
Timers Communication interfaces Human maching interfaces
GPT32x & SClx6 e = 2 [3C CEU
GPTI6x 6
AGT =2 OSPI SDHI x 2 ETHERC
ULPT x 2 SPIx2 CANFD x 2 USBHS
RTC
SSIE x 2 USBFS
WDTAWDT
Event link Security Data processing Analog
ELC RSIP-ES1A CRC ADCA2 %2 DAC12 x 2
DOTF DoC ACMPHS x 2 TSN
Figure 2. Block Diagram of Renesas RA8M1 MCU
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2.3 Single Instruction Multiple Data

Most Arm® instructions are Single Instruction Single Data (SISD) instructions. The SISD instruction only
operates on a single data item. It requires multiple instructions to process data items.

The Single Instruction Multiple Data (SIMD), on the other hand, performs the same operation on multiple
items of same data type, concurrently. It means invoking/executing a single, multiple operations are being
performed simultaneously.

Figure 3 shows the operation of VADD.I132 Qd, Qn, Qm instruction that adds the four pairs of 32-bit data
together. Firstly, the four pairs of 32-bit input data are packed into separate lanes in two 128-bit Qn, Qm
registers. Then, each lane in the 1t source register is then added to the corresponding lane in the 2™
source register. The results are stored in the same lane in the destination register Qd.

eUBN 1 2 3 | 4

am |

Qd | | | | |

Figure 3. Operation of VADD.I32 Qd, Qn, Qm Instruction

2.4 Helium™ Applications

Digital Signal Processing (DSP) and Machine Learning (ML) are the main target applications for Helium™.
Helium™ offers significant performance increases in these applications. Typically, Helium applications are
created using Helium intrinsics.

Helium instructions are made available as intrinsic routines through the arm mve.h in AR EWARM
installation, located in TAR Systems\Embedded Workbench x.x\arm\inc\c\aarch32. They give
users access to the Helium instructions from C and C++ without the need to write assembly code.

Many functions in CMSIS-DSP and CMSIS-NN libraries have been optimized by Arm to use the Helium
instructions instead. Renesas FSP supports both libraries, making it easier for users to develop applications
based on these libraries. In the FSP configuration, select Arm® DSP Library Source (CMSIS5-DSP version
5.9.0 or later) and Arm NN Library Source (CMSIS-NN version 4.1.0 or later) when generating projects to
add CMSIS-DSP and CMSIS-NN supports to your project.
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w

Generate Project Content

= 2k Group by: |Vendor ~ | Filter: | All v

Component Version Description Variant
% Abstractions
w iy CMSIS
w @ CMSIS3
CoreM 5.9.0+renesas.0fsp.5.0.0  Arm CMSIS Version 5 - Core (M)
DSP 5.9.0+renesas.0.fsp.5.0.0  Arm DSP Library Source
[/] NN 4.1.0+fsp.5.0.0 Arm MM Library Source
o mbed
& Mbed
o PSA
o= AWS
=5 Intel

Components Configuration

~

= Linaro
= Microsoft
w 9, Renesas
w g%y BSP
~ ¥ Board
[[] custom 500 Custom Board Support Files
[[] ra2al_ek 500 RA2A1-EK Board Support Files

[T ra2a2 ek 5.0.0 RAZAZ-FK Boa
Summary | BSP | Clocks | Pins | Interrupts | Event Links | Stacks| Cemponents |

d Suppert Files

Figure 4. CMSIS-DSP and CMSIS-NN supports in Renesas FSP
CMSIS-DSP and CMSIS-NN can also be added using Stacks tab in FSP configurator, as shown below.

Stacks Configuration 0 =] 22 H =B

Generate Project Content

HAL/Common Stacks &) New Stack >
=] Analog

PEE == -
~ &¢ HAL/Common & (gr_lizfjon:tt)uo Port Artificial Intelligence

42 g_icport IO Port (r_ioport) Audic

@ Bootloader
Lonnectivity

| DsP
Graphics

Threads

4 Arm CMSIS5 NN Library Source
4+ Data Collector (rm_rai_data_collector)
4 Data Shipper (rm_rai_data_shipper)

Input
Menitoring
Motor
Metworking
Power

Security

Sensor
Objects Storage
System

Timers

Transfer

N e VY B I I

4" Search...

Summary | BSP | Clocks | Pins | Interrupts | Event Links Compenents » Legend

Figure 5. Adding CMSIS-DSP and CMSIS-NN Using Stacks Tab in FSP Configurator
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3. Helium™ Support in Renesas FSP and IAR EWARM

IAR EWARM supports Helium™ instructions with the compiler settings. When generating a RA8M1 project
using Renesas RA Smart Configurator and Flexible Software Package (FSP), CPU settings and software

settings are pre-optimized for Cortex-M85 core and the CMSIS Helium™ support. Refer to the Renesas RA
Smart Configurator Quick Start Guide for creating an IAR EWARM project for RA§ MCU.

ﬁ ew Renesas RA Project

New Renesas RA Project

Device and Tools Selection

Device Selection

FSP Version:

Board: EK-RASM1
Device: R7FASMIAHECED
Core: Cmas

Language: ®C (O C++

O

Board Description
Evaluation kit for RASM1 MCU Group

Visit TBD to get kit user's manual, quick start guide, errata, design
package, example projects, etc.

Device Details
TrustZone Yes
Pins 224
Processor Cortex-M85

IDE Project Type
I1AR EWARM

Toolchains

IAR Toolchain for ARM

< Back Finish Cancel

The Cortex-M85 core will be selected in IAR EWARM settings, as shown below.

Figure 6. Create an EK-RA8M1 Project using Renesas RA Smart Configurator

Categony:

Static Analysis
Runtime Checking
C/C++ Compiler
Assembler
Output Converter
Custom Build
Linker
Build Actions
Debugger
Simulator
CADI
CMSIS DAP
E2/E2 Lite
GDEB Server
I-et
Jinkf1-Trace
TI Stellaris
Mu-Link
PE micro
STLIMEK

TI MSPFET
TIXDS

General Options

Library Configuration
Target

Processor variant

Library Options 1 Library Options 2
32bit E4bit Output

(D) Core

Cortex-M85

(®) Device

Renesas RTFABM1AH Eh

(O CMSIS-Pack

None

Third-Party Driver

Execution mode
32bit
B4-bit

()3 Cancel

Check Project > Options > General Options to confirm if SIMD (NEON/HELIUM) is selected.

Figure 7. Confirm Project Settings on IAR EWARM
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Categony:

Static Analysis
Runtime Checking
CJC++ Compiler Library Configuration Library Options 1 Library Options 2
Assembler Target 32bit B4-bit Output
Qutput Converter
Custom Build
Linker Litte FPU: VFPv5 double precision
Build Actions Big
Debugger BE
Simulator BE
CADI
CMSIS DAP
E2(E2 Lite TrustZone
GDB Server DSP Extension
I4et Advanced SIMD (NEON/HELIUM)
#'S"ht{; e [ Foirter authentication (PACBTI)
Nu-Link
PE micro
ST-LINK
Third-Party Driver
TI MSP-FET
TIXDS

Byte order Floating-point settings

2 D registers: 16 w

== R

Mode: | Secure ~

(]9 Cancel

Figure 8. Example of Helium Selection in IAR EWARM

Even though, the project settings are pre-optimized for Cortex-M85, they can be customized if needed.
Macro definitions can be added to select project configurations to enable and disable some portions of the
code in an IAR EWARM project. Go to Project > Options to change setups for the project if needed. The
project settings can be confirmed using the Build Messages window on IAR EWARM. Some highlight
settings for RA8 MCUs are marked in red below.

Build

Messages
YWarnings: none

board_init.c

"CAProgram Files\AR Systems\Embedded YWorkbench 8. 2%armibinyiccarm.exe" Chwoarking\loTvactive_Projects\High_Ferformance_RASV0_11_2ZHAHELIUM_EK_RAGKMIY
HELIUM_whLA_EK_RASMIralboardiradm_ekiboard_initc-D _CONFIG_HELIUM_=0-D _RENESAS_RA_-D_DCACHE_ENABLE_ D—oC\WDrkl
noilo TyActive_ProjectsiHigh Performance BASI0 11 23WHELIUM EE_BAGMIVHELIUM_VMLA_EK_RABMTY32_SCALARNDb\Componenfs_ hhaThORa082 dir—
debug —endian=litled—cpu= Cortex-M85.no _pacht —cmse -e —fpu=vYFPWE_d16 |-dlib_config "CAProgram Files\AR Systems\Embedded Workbenchg2\arm\|nc\c\Dle Con
fig_Marmal.h" - G4 1_23HELILM_EK_RASMTHELIUM_WiLA_EK_RAGMI frafarm/CMSIS_5/CMSIS/Corefinclu
delH CworkingiloTyActive_ Pro]ects‘-,ngh Pen‘ormance _FaAamI0_ 11 23\HELIUM EK_RASMTHELIUM_ WMLA_EK_RASMI fraffspfing 4 Ciworkingylo TyActve_Projectsi\H
igh_Performance_RAB0_11_2WHELIUM_EK_RABMTYHELILIM_ WhLA_EK_RABMI rafsplinc/api, - ChWorkingilo ThyActive_Projects\High_Performance_RAS0_11_23H
ELIUM_EE_FASMIYHELIUM _VILA_EK_FABMI fraffsp/inciinstances -l ChWWorkingyo ThActive_Projects\High_Perormance_RASI0_T1_2MHELIUM_EK_RASMTYHELIUM
_wWhALA_EK_RAGMI fra_cigffsp_cig, -l CiwvvorkinghloTyvactive_Frojects\High_FPerformance_RASV 0_11_23#HELIUM_EK_FASMIYHELIUM_VLA_EK_FAGMM1/fra_cig/fsp_cf
gfbspy -l Ciworkingylo TvActve_Projects\High_Ferdarmance_RAS0_11_2HELIUM_EK_RABMTHELIUM_WLA_EK_FASM1 fra_gen', -l Ciworking\lo TVActive_Frajectsh,
High_Performance_RAS 0_11_2 AHELIUM_EK_RASMTHELILIM_WhLA_EK_RASMI fsrdh -l ChWorkinghlo TvActive_Projects\High_Performance_RAST0_11_23HELIUM_
EK_F&8h1/commaony -Oh

IAR ANS| C/C++ Compiler ¥9.40.1.364A4E4 for ARM
Copyright 1999-2023 1AR Systerns AB.

Figure 9. Example of Build Command on IAR EWARM
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4. Application Project

There are three projects accompanying this application note. All have the scalar code equivalent to Helium
functions.

e The Vector Multiply Accumulate (VMLA) and the scalar code equivalent.

e The Vector Multiply Accumulate Add Accumulate Across Vector (VMLADAVA) and the scalar code
equivalent.

e The ARM DSP Dot Product function and the scalar code equivalent.

The projects are configured in various settings to utilize DTCM, ITCM, and cache to showcase the
performance improvements of Helium technology compared to scalar code.

HELIUM_EK_RAZM1

Mame

commen
HELIUM_DOT_PRODUCT_EE_RAZM1
HELIUM_VMLA_EK_RAZM1
HELIUM_VIMLADAVA_EK_RAZMI
settings

| | HELIUM_EK_RABM1.custom_argvars

& HELIUM_EK_RABMI.eww

Figure 10. Application Projects in the Workspace

The available configuration for each project is as follows.

Project HELIUM_VMLA_EK_RASM1 | HELIUM VMLADAVA EK RASM1 | HELIUM DOT PRODUCT EK_RASM1

Configuration

132_SCALAR v v v
132_HELIUM v v v
132_HELIUM_DTCM v v v
132_HELIUM_ITCM v v

Figure 11. Configuration Available in Application Projects

Where 132_SCALAR is for the scalar code, 132_HELIUM is for the Helium code, 132_HELIUM_DTCM is for
the Helium code that utilizes DTCM, and 132_HELIUM_ITCM is for the Helium code placed ITCM.

The projects in this application note are set to "High” and “Balanced" as shown in the following screenshot.
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Cateqary:

General Options
Static Analysis
Runtime Checking
CfC++ Compiler
Assembler
Output Converter
Custom Build
Linker
Build Actions
Debugger
Simulator
CADI
CMSIS DAP
E2/E2 Lite
GLB Server
I-jet
Iink/3-Trace
TI Stellaris
Nu-Link
PE micro
STLIMNK
Third-Party Driver
TI MSP-FET
TIXDS

Factory Settings
[ Muiti-file Compilation

Dizcand Unuzed Publics

List Preprocessar Diagnostics Encodings Extra Options
Language 1 Language 2 Code Optimizations Output
Level Enabled transformations:
() Nane [#]Common subexpression elimination
O Low Loop unrolling
) Medi Function inlining
SOum [#]Code mation

(®) High ype-based alias analysis
[+ Static clustering
Balanced e Instruction scheduling
No size constraints | | Vectorization

QK. Cancel

Figure 12. EWARM Compiler Optimization Setting

The _CONFIG_HELIUM_ symbol is preset to select scalar operation, Helium Operation, or enable the code

to utilize DTCM and ITCM.

Categony:

General Options
Static Analysis
Runtime Chedking

C/C++ Compiler
Assembler
Output Converter
Custom Build
Linker
Build Actions
Debugger
Simulator
CADI
CMSIS DAP
E2/E2 Lite
GDE Server
I-et
Jink/1-Trace
TI Stellaris
Nu-Link
PE micro
STLIMK
Third-Party Driver
TI MSPFET
TLXDS

Factory Settings
[ Muti-file: Compilation

Dizzard Unused Publics

Optimizations Output
Extra Options

Language 1 Language 2 Code

List Preprocessor Diagnostics Encodings

[Jlgnore standard include directories

Addtional include directories: (one per line)

SPROJ_DIRSra/am//CMSIS_5/CMSISCore/Include -~
SPROJ_DIRS/rafep/ine

2PROJ_DIRS/rafsp/inc/api

2PROJ_DIRS/ra/fep/inc/instances

SPROJ_DIRS/ra_cfgAsp_cfa ]

Preinclude file:

Defined symbols: (one per ling)
_CONFIG_HELIUM_=1

[] Preprocessar outpt to file

_REMNESAS_RA_ Preserve comments
_DCACHE_ENABLE_=0 Generate Hline directives
_RA_CORE=CM8%

Ok Cancel

Figure 13. _CONFIG_HELIUM_ Symbol Used to Select Helium Code and Scalar Code Options
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4.1 Vector Multiply Accumulate Instruction VMLA Example

In VMLA instruction, each element in the input vector2 is multiplied by the scalar value. The result is added
to the respective element of input vector1. The results are stored in the destination register.

The steps of VMLA.S32 Qda, Qn, Rm instruction are shown in the following figure.

Vector2 32 33 34 35

Scalar value X2 x2 X2 X2
\ | \ \ |
+ + + +
Vectorl
Result 64 67 70 73

Figure 14. VMLA Operation

The intrinsic function vmlag_n_s32 in Figure 15 is used to showcase the performance of VMLA.S32 Qda,
Qn, Rm instruction versus the scalar equivalent.

datal[i] += (data2[i] * scalarval); Disassembly

/’/}’Gét the timer counter O=200'0700: Oxfl04e Oxel01 DIS IE. 1R
ts_cycle = R_GPT@->GTCNT;; 0x200'0704: 0xf105 O0=0810 ADD.W RE. R5. #16
#elif (_CONFIG_HELIUM_ == I32 HELIUM) || (_CONFIG_HELIUM_ == I32_HELIU 0=200'0708: 0x£f105 0Ox0cl0 ADD.W R12, RS, #16
vectorl = wldlg =32(p_datal):
] #1f (_CONFIG_HELTUM_ == T32_HELTUM) I (_CONFTG_HELTUM_ == T32_HELTUM_ 27hal entrw 3
;;f‘?: :“;f“;ff&;g_:ofufﬂ? at a time, the loop will be 32/4 = & 0x200'070c: Dxed94 0x1£00 VIDRW.32 00, [R4]
= 0x200'0710: Oxed85 0=1f00 WSTREW.32 Q0. [RS]
//Load 4 data from the array vectorl = wldlg s3Z2(p_dataz):
vectorl = vldlq_s32(p_datal); 0x200'0714: Oxed96 0x1£00 WLDREW.32 Q0. [R6]
vector2 = vldlq_s32(p_data2); 0x200'0718: OxedSc O0x1£00 WSTREW.32 Q0. [R12]
® SfMultiply (vector2*scalarval), add vectorl and store the resuld] result[i] = vmlag n s32(vectorl, wector2, scalarval):
”;;t;;aif 4"“,”” < 0x200°'0720: Oxed95 0x2£f00 VIDRW.22 Q1, [RS)]
E:dataz +; 4; 0=200°'0724: OxesZl O0x2ed4? VHMLA.S32 Q1. Q0. R7
- 1 0x200'0728: OxedB83 0x3f00 V¥STRW.32 Q1. [R3]
/fGet the timer counter p datal += 4
ts_cycle = R_GPT@->GTCNT; 0x200'072c: 0=x3410 ADDS R4, R4, 16
[ #endif p_data? += 4;
0x200'072e: O0x3610 ADDS R&. RB. #16

Figure 15. Example of VMLA Instruction Using Intrinsics and Disassembly Code

Figure 16 shows the scalar code equivalent to the Helium code in Figure 15.

Cev=

#if (_CONPIG HELIUM_ == I32 SCALAR) 0x200'06ac: Oxeb03 020345 ADD.W R3. R3. RS, ISL #1
Tor (1 < 05 1<DAT BUF S1ZE; 1e4) 0x200'06b0: 0x=600b STR R3. [R1]
— { datal[1] += (datal[1] * =calarwval):
datal[i] += (data2[i] * scalarval); —
E = y 0x200'06bE: Ox684b LDR R3. [R1. #0ud]
//Get the timer counter 0=200'06b8: 0Oxeb03 0x0345 ADD. W R3. RE3. RG5. LSL #1
ts_cycle = R_GPT@->GTCNT;; 0x200'06bc: Ox604b STR R3. [R1. #0ud]
#elif (_CONFIG_HELIUM_ == I32_HELIUM) || (_CO datal[i] += (data2[i] * scalarval):

5] #iF (_CONFIG HELTUM == T32 HELTUM) || (_CONF 0x200'06bs: 0xf852 0x5b04 IDR.W RS, [R2]. #0m4
=TS - — 0x200'06c2: Ox688b LOR R3. [R1. #0x8]
//5ine calculating 4 outputs at a time, t

i for (i = B; i<LOOP NO; i++) 0x200'06c4: Oxeb03 0x=0345 ADD W R3. R3, RS, LSl #1

= 0x200'06c8: 0x608b STR R3. [R1. #0x8]

/fLload 4 data from the array datal[i] += {(dataZ[i] * scalarwval):

vectorl = vldlg_s32(p_datal); 0x200'06ca: 0O=f852 O=xSb04 LIDR.W RE. [R2]. #0=4
vector2 = vldlg_s32(p_data2); 0x200'06ce: 0x68ch LDR R3. [Rl. #0xc]
//Multiply (vector2*scalarval), add vec 0x200°'06d0: Oxeb03 0x0345 ADD.Y R3. R3, RS, LSL #1
result[i] = vmlaqn_s32(vectorl, vector %200 06d4: 0x60ch STR R3. [Rl. #0xc]

/S Increase pointers = = = — 2

Figure 16. Example of Scalar Code Equivalent of VMLA and Disassembly Code
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4.2 Vector Instruction VMLADAVA Example

The VMLADAVA instruction multiplies the corresponding lanes of two input vectors, then sums these
individual results to a produce a single value.

The steps of VMLADAVA.S32 Rda, Qn, Qm instruction are shown in the following figure.

Qo 32 33 34 35

Ql

RO

RO input

RO output

Figure 17. VMLADAVA Operation

The intrinsic function vmladavaq_s32 in Figure 18 is used to showcase the performance of VMLADAVA.S32
Rda, Qn, Qm instruction versus the scalar equivalent.

HTLL1 | _ LUl LU_NILLLUN —— LJe_(LLLUMT) || L_wuie Lu_ticLiur —— L -
wvectorl = wldlg =32({p_datal):
#if (_CONFIG_HELIUM_ == I32_HELIUM) || (_CONFIG_HELIUM == 132 || 7%hal_entry_3:
//5ine calculating 4 outputs at a time, the Loop will be 3 0x200'070=: Oxed95 Ox1f00 VIDRW.32 Q0. [RS]
‘E‘” (1 = @; 1<LOOP_NO; i++) 0=200'0712: Oxed84 Ox=1£00 VSTRW.32 Q0. [R4]
— wvectors = vldlg =32(p datal):
//load 4 data from the array R .
vectorl = vldlg_s32(p_datal); 0=200'0716: Oxed96 0=x1f00 VIDEW.32 Q0. [R&]
vector2 = vldlq_s32(p_data2); 0=x200'071a: Oxed88 0=x1f00 VSTREW.32 Q0. [RE8]
//Perform (vectorl*vector2), sum 4 multiplication resulfp |i result[i] = wnladavag s32(scalarval. wectorl, wectord)
//Increase pointers 0=200'0722: 0Oxed94 0=3f00 VIDEW.32 Q1. [R4]
p_datal += 4; 0=200'0726: 0x2002 MOVS RO, #2
p_data2 += 4; p_datal += 4:
S e _ O0=x200'0728: 0=3510 ADDS RS, RS, #16
//Get the timer counter
ts_cycle = R_GPT@->GTCNT;; 0x200'072a: Oxeefld 0020 VHLAVA S32 RO, Q1. QO
#endif - 0=x200'072=: 0x£f847 0=0b04 STR.W RO, [R7]. #0=4
p datal += 4

Figure 18. Example of VMLADAVA Instruction Using Intrinsics

Figure 19 shows the scalar code equivalent to the Helium™ code in Figure 18.
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#if {_CONFIG _HELIUM == I32 SCALAR)
L Perform scglgr cgleylgiion (Fguivglent wifh fhe WA
For (=08 i<DAT BUF_SIZE; i += 4)
{
for(j =

AVA

B; j<d; j++)
datal[i+j] *= data2[i+]j];

j
for(j = @; j<4; j++)
result[i/4] += datal[i+j];

result[i/4] += scalarval;

//Get the timer counter
ts_cycle = R_GPT@->GTCNT;
#elif (_CONFIG_HELIUM_ == I32 HELIUM) || (_CONFIG HELIUM == T

#if (_CONFIG HMELIUM == I32 HELIUM) || (_CONFIG HELIUM_ == I32
//5ine calculating 4 outputs at a time, the loop will be 3
for (1 = @; i<LOOP_NO; i++)

1
//load 4 data from the array
vectorl = vldlq_s32(p_datal);
vector2 = vldlq_s32(p_data2);
//Perform (vectorl*vector2), sum 4 multiplication result
result[i] = vmladavaq_s32(scalarval, vectorl, vector2);
//Increase pointers
p_datal += 4;
p_data2 += 4;

//Get the timer counter

ts_cycle = R_GPT@->GTCNT;;
#endif
#if (_CONFIG_HELIUM_ == I32 HELIUM ITCM)

//Fuction placed in ITCM section
item_func();
#tendif //(_CONFIG_HELIUM == I32 HELIUM ITCH)

#endif //(_CONFIG HELIUM == I32 HELIUM) || (_CONFIG HELIUM =
R_GPT@->GTCR = @; //Stop timer

#if (_DCACHE_ENABLE_ == DCACHE_ENABLE_YES)
5CB_DisableDCache(); // Disable Dcache

#endif
//Print timer cycles
APP_PRINT("Timer counter cycle: %d \n", ts_cycle);

//Printing the results

£far (3 — A« F/10ND KN S0

Disassembly

for (1 = 0:

0z200'06%:
0=200'06a2:

i<DAT_EUF_SIZE: i += 4}
0z£105 0x0120 ADD.W
0xf105 0x02a0 ADD.W

datal[i+]] *= data2[i+3]:

??hal_entry 0

O0=200'06a6: O0x680b LDE
O0=200'06a8: 0=xf852 Oxeb04 LDR.W
O0x200'06ac: 0x4373 MUOLS
O0=200'06a=: O0x600b STR
datal[i+7] *= data2[i+3]:
O0=200'06b0: O=684f LDE
O0=200'06b2: 0=xf852 Ox3b04 LDR.W
datal[i+]] *= data2[i+]]:
O0=200'06b6: Ox688= LDE
O0=200'06b8: 0=435f MOLS
O0=200'06ba: O=x604f STR
O0=200'06bc: 0=xf852 O0x3b04 LDR.W
for(j = 0; j<4; j++)
O0=200'06c0: O0x1067 ASRS
result[i-4] += scalarval:
0=200'06c2: O0xf8dl Oxc004 LDR.W
O0=200'06c6: Ox43G= MULS
Ox200'06c8: 0x608e STR
0x200'06ca: Ox68ce LDR
O0=200'06cc: O0=x£852 O0x3b04 LDR.W
O0=200'06d0: 0x43G= HULS
O0=200'06d2: O=xeb04 0x7397 ADD.W
O0x200'06d6: 0Ox6lce STR
Ox200'06d8: O0x680f LDR
for (i = 0; i<DAT BUF _SIZE: 1 += 4)
O0=200'06da: 0Ox1d24 ADDS
O0=200'06ds: 0=x£f023 0x0303 BIC.W
0=200'06e0: OxS8es LLR
O0x200'0622: 0xl9be ADDS
0=200'06=4: Ox4466 ADD
O0=200'06e6: O=688f LDR
O0=200'06=8: 0=xf8dl OxcO00c LDR.W
O0=200'06ec: 0x3110 ADDS
O0x200'06e=: 0xl9%b= ADDS
O0=200'06f0: Ox4466 ADD
O0=200'06£2: Oxlchb ADDS
for (i = 0; i<DAT BUF SIZE; i += 4}
O0=200'06f4: O0x2c20 CHP
O0z200'06f6: Ox50e= STR
O0x200'06f8: O0xd3ids BCC . N

R1.
Rz,

ER3,
RE,
R3.

E7.
ER3,

RE.
R7.
R7.
R3.

R7.

R12,
R&.
R&.

R3.
RE .

R6.

R12,
El.
R6.
RE.
R&.

R4,
R6.

?thal_entry 0

#32
#160

RS,
RS.

[R1]
[R2].
R&. R3
[R1]

#0=4

[R1.
[R2].

#0x4]
#0=4

[R1.
R3.

[R1.
[R2].

#0=8]
R7
#0z4]

#0=4
R4, #1

[R1,
R3. RE
[R1, #0xB]
[R1. #0xc]
[R2]. #0=4
R3. RE
R4, R7. LER #3
[R1, #0xc]
[R1]

#0=4]

R4,
R3.
[R5,
R7.
RE.

#4
#3

R3]
6
R12
[R1. #0x8]
[Rl. #0xc]
Rl. #16
R?. RE
R&. R12
R&. #2

#32

[R5, R3]

Figure 19. Example of Scalar Code Equivalent of VMLADAVA Instruction and Disassembly Code
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4.3 ARM DSP Dot Product Example

The dot product example uses the arm_dot_product_f32 function in the Arm DSP library to calculate the dot
product of two input vectors by multiplying element by element and sum them up. The performance of the
Helium version of arm_dot_product_f32 will be compared with its scalar version.

main.c  hal_entry.c arm_dot prod f32.c x main.c
arm_dot_prod_f32[const float32_t *, const float32_t *, uint32_t, float32_t*)

Disassembly

Go ba:‘ v| Zone: |Memory v|

Bparamfout ] result output result returned here.
@return none
*

Bl #if defined(ARM_MATH_MVEF) && !defined (ARM_MATH_AUTOVECTORIZE)

#include "arm_helium_utils.h™

[ void arm_dot_prod_f32(
const float32_t * pSrcA,
const float32_t * pSrcB,
uint32_t blockSize,
= float32 t * result)

324 t wvech, vecB;
fa2xa_t vecSum;

uint32_t blkCnt;

float3z_t sum = 9.0T;

vecSum = vdupg_n_f32(@.ef);
Compute 4 outputs at a time */
blkCnt = blockSize »> 2U;

while (blkCnt > eU)

* C = A[8]* B[8] + A[1]* B[1] + A[2]*
# Calculate dot product and then store
* gnd advance vecter source and destination peinters
y

o

e
pSrcA += 43
vecB = vldlq(pSrcB);
pSrcB += 4;
vecsum = vimaq(vecSum, vech, vecB);
= /*
# Decrement the blocksSize loop counter
blkCnt --;
F ¥
blkCnt = blockSize & 3j;
if (blkCnt > eu)
= {

..+ A[blockSize-1]* BfblockSize-1]
the result in @ temporary buffe

Digassernbly
0x200'0b32: 0xf041 0xcB0S WLS LR. R1. ?7arm_fill
#*pDst++ = value:
Prarm_fill £32_ 3:

0=x200'0b36: Ozxed80 0x0a00 VSTR S0, [RO, #07
0x200'0b3a: 0x1d00 ADDS RO. RO, #4

while {(blkCnt > 0U)

0=x200'0b3c: 0=f00f OxcH0S LE LE. ?7arm_fill £32_3

?rarn_fill £32 2:
0x200'0b40: 0xbd00 POP {PC}
void arm_dot_prod_f32(
const float32_t * pSrod.
const float32_t * pSrcB,
uint3?2_t blockSize,
float32_t * result)

i
arn_dot_prod_£32:
0x200'0042: 0=b530 PUSH {R4, RS, LR}
wecSum = wdupg n £32(0 0f):
0x200'0b44: O0=2400 HOVS R4, #0
blkCnt = blockSize »: 20;
0x200'0b46: 0x0B9S LSRS RS, Rz, #2
0x200'0b48: Ozeeal 0x4bl0 VDUP.32 Q0. R4
0=200'0b4c: O=f045 0xcO0b  WLS LE. RS, ?7arm_dot_

vech = wldlq(pSrch);
??arn_dot_prod_f£32_1

wvecB = wldlgipSrcE):
0z200'0b54: Oxedd1l 0xS5£00 VLDRW.32 Q2. [Rl]

0=x200'0b5%8: 0=3010 ADDS RO. RO, #16
pSrcB += 4
0=x200'0b5a: 0=3110 ADDS Rl. R1. #16

vecSun = vimag(wvecSum, wech, wecB):
0x200'0b5c: Oxef02 0x0cS4 VEMA F32 Q0. Q1. Q2
while (blkCnt > 0T}
0=200'0be0: O0=xf00f OxcOO0b LE LR. ?7arm_dot_prod
blkCnt = blockSize & 3.

?rarm_dot_prod £32_0

0x200'0b6d: 0xf012 0x0203 ANDS.W R2. Rz, #3
0x200'0b68: 0=4696 MOV LR. R2
i1f (blkCnt » 00}

Figure 20. arm_dot_product_f32 Function with Helium™ Code

Renesas Flexible Software Package FSP supports Arm DSP Library Source for Cortex-M85 that uses
Helium intrinsics. It will improve performance significantly compared to scalar code. Select Arm DSP Library
Source in Project Configurator to add the DSP source to your project, as shown in Figure 21.
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. . 0
Components Configuration Generate Project Content
= 2k Group by: |Vendor ~ | Filter: | All ~
Component Version Description Variant ™
&% Abstractions
v @ CMSIS
v @ CMSIS3
CoreM 5.9.0+renesas.0.fsp.5.00  Arm CMSIS Version 5 - Core (M)
L[V D5P 5.9.0+renesas.0.fsp.5.0.0 _ Arm DSP Library Source |
[ NN 4.1.0+fsp.3.0.0 Arm NN Library Source
% mbed
& Mbed
@ PSA
B WS
5 Intel
5, Linaro
= Microsoft
v 3, Renesas
~ @ BSP
v & Board
[[] custom 5.0.0 Customn Board Support Files
[[] raZal_ek 5.0.0 RAZAT-EK Board Suppert Files
[ ra2a2 ek 5.0.0 RAZAZ-EK Board Support Files 7
Summary | BSP | Clocks | Pins | Interrupts | Event Links | Stacks | Components|
Figure 21. Adding Arm Library DSP Source in FSP Configurator
Click Generate Project Content, the Arm DSP library source will be added to the project.
File Edit View Project J-Link Tools Window Help
NN RS = W0 O C
Workspace * 0 X
132_HELIUM v
Files = 2
=2 @HELIUM_DOT_PRODUCT_EK_RA8M1 -132_H... +
£ W Flex Software
Bl Build Canfiguration
=R |Components
arm_abs_f16.c
arm_ahs_f3%.c
arm_abs_fGd.c
arm_abs_ngl6.c
arm_abs_gdl.c
arm_ahs_g7.c
arm_absmax_f16.c
arm_absmax_fiZ.c
arm_absmax_f6d.c
arm_absmax_nao_idx_f16.c
arm_absmax_no_idx_{32.c
arm_absmax_nao_idx_fid.c
arm_absmax_no_id«_g15.c
arm_absmax_no_id«_g31.c v
COverviews  HELIUM_DOT_PRODUCT_EK_RABM1 HELILIBA_WH 4 | v
Figure 22. Arm Library DSP Source Added in FSP Project
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4.4 Performance Improvement

You can utilize Tightly Coupled Memory (TCM) and Cache together with Helium™ to achieve higher
performance. Typically, TCM provides single-cycle access and avoids delays in data access. Critical routines
and data can be placed in TCM areas to ensure faster access. TCM does not use caches.

4.4.1 Tightly Coupled Memory (TCM)

The 128 KB TCM memory in RA8 MCU consists of 64 KB ITCM (Instruction TCM) and 64 KB DTCM (Data
TCM). Note that accessing TCM is not available in CPU Deep Sleep mode, Software Standby mode, and
Deep Software Standby mode.

Figure 23 shows ITCM and DTCM in the Local CPU Subsystem.

Local CPU subaystem (CPUD) l

»| AHB-AP

Cortex-MES

1

TFRIU

L 4

¥ h J

I-TCM | (D-TCM

M-AXI P-AHE
¥ L
System bus

Figure 23. ITCM and DTCM in Local CPU Subsystem

FSP initializes both ITCM and DTCM areas by default. The linker script has defined sections for ITCM and
DTCM areas, making it easy to utilize in user applications.
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Figure 24 and Figure 25 are snapshots of ITCM and DCTM locations in RA8 MCU.

0x1300_A300
0x1300_A100

0x1300_81B4
0x1300_80F0
0x122F_5000

(x¢1200_0000

dx1001_0000
0x1000_0000

0x0300_A300
0x0300_A100

Ox0300_81B4
0x0300_80F0
0x022F_8000

0x0200_0000

(0x0001_0000
(0x0000_0000

Reserved area*®

On-chip flash (option-settimg memony)

Reserved area™

On-chip flash (Factory Flash)

Reserved area™

On-chip flash (code flash)
(read only)™

Reserved area™

ITCM

Non-
Secure

Reserved area*?

On-chip flash (option-setting memeony)

Reserved area*

On-chip flash (Factory Flash)

Reserved area*

On-chip flash (code flash)
read only)**

Reserved area*®

ITCM

Mon-

seCUre
callable
for CPU

Secure
for other
bus
masters

Figure 24. Example of ITCM Areas in RA8 MCU
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0x3001_0000 Reserved area*?
0x3000_0000 DTCM -
0x2703_0400 Reserved area
0x2703 0050 On-chip flash (option-setting memaony
_| Non-
0x2700_3000 Sl ceeure
0x3700 0000 | On-chip flash (data flash) callable
DxZﬁDﬂ_DdJDO Reserved area*? for CPU
. Standby SRAM
0x2600_0000 R S — Secure
0x220E_0000 for other
0x2200_0000 On-chip SRAM bess
- masters
0x2001_0000 Reserved area™
0x2000_0000 DTCM
Reserved area*?
0x1300_A300
0x1300_A100 On-chip flash (option-setting memony)
0x1300_81B4 Reserved area*
On-chip flash (Factory Flash) Maon-
0x1300_80F0 ot o
0x122F_8000 eserved area™
On-chip flash {code flash)
Ox1200_0000 (read only)™
Reserved area™
(0x1001_0000
0x1000_0000 ITeMm
Reserved area*?
0x0300_A200 Non-
0:0300_A100 | On-chip fiash (option-satting memory) Secure
Reserved area*? callable
Ox0300_81B4 : far CPLU
0x0300_80F0 On-chip flash (Factory Flash)
0x022F_8000 Reserved area™ Secure
= - for other
On-chip flash {mqie flash) bus
0x0200_0000 read only) mhissbers
Reserved area*?
0x0001_0000
0x0000_0000 ITcMm

Figure 25. Example of DTCM Areas in RA8 MCU

4.4.2 Improve Performance Using DTCM

You can place data in the DTCM section (.dtcm_data) in an FSP-based project using the _attribute_
directive, as shown in Figure 26.

#if (_CONFIG_HELIUM_ == I32 HELIUM) || (_CONFIG HELIUM == I32 HELIUM_ITCM)
static int32x4 t wvectorl;

static int32x4 _t wvector2;

static int32x4 t result[5];

#elif ( CONFIG HELIUM == I32 HELIUM DTCM)

static int32x4 t  attribute ((section(".dtcm_data"™)
static int32x4 t  attribute ((section(".dtcm_data™)
static int32x4 t  attribute ((section(".dtcm_data™)

1) vectorl;
1) vector2;
1) result[E];

Figure 26. Placing Variables in DTCM Section
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The above data placement can be confirmed using the memory map generated by the compiler.

g_bsp_rom_pbps_sec3 Bx388 "a26c Bx4 Data Lc bsp_rom_registers.o [1]
g_bsp rom_sas Bx300"'al34 Bx4 Data Lc bsp rom registers.o [1]
g_clock_freqg Bx228@'8eld  8x2c Data Lc bsp_clocks.o [1]
g_fsp_wersion Bx208 " 11dc Bx4 Data Lc bsp_common.o [1]

g fsp wersion_build string

@x28@"11e8 ©x44 Data Lc bsp_common.o [1]
g_fsp_wversion_string Bx208 " 11lecl Bx3 Data Lc bsp_common.o [1]
g_interrupt_ewvent_link select

@x2@@'ee4d oxc® Data Wk bsp_irg.o [1]

g_ioport_ctrl Bx226@"8l4dc Bx8 Data Gb common_data.o [2]

g _main_stack Bx22808'8alld ex48@ Data Lc startup.o [1]

g_prcr_masks Bx200 ' 8684 Bx8 Data Lc bsp register_protecticn.o [1]
g_protect_counters Bx226@'0144 Bx38 Data Gb bsp_register_protection.o [1]

g_protect_pfswe_counter
Bx2200'e14R Bx4 Data Gb bsp ic.o [1]

g_vbatt_pins_input Bx200 " ad6d Bx8 Data Lc r_jioport.o [1]
hal_entry Bx200'867d  Bxe2 Code Gb hal_entry.o [3]
main Bx2808'1191 Bxa Code Gb main.o [2]

r_ioport_pfs_write @x28@'8c5b  @x2e Code Lc r_ioport.o [1]
r _ioport pins config Ax208'8c2b _ Bx38 Code Lc_ r_ioport.o [1]
result Bx22008'00828 8x88 Data Lc |hal_entry.o [3]
vectorl Bx2006"'ea2@ 6xle Data Lc fhal_entry.o [3]
vector2 Ax2288'eala  8xl@ Data Lc Jhal_entry.o [3]

Figure 27. Example of Variables Placed in DTCM Area in Memory Map

4.4.3 Improve Performance Using ITCM
One of the methods to place some portions of the code in the ITCM section (. itcm data) is using the
#Pragma directive, as shown in Figure 28.

#if (_CONFIG_HELIUM_ == I32 HELIUM_ITCM)
//Placing functions in section .itcm data
#pragma default function_attributes = @ ".itcm_data™
void item func{wveid)
1
int i;
#/Pointer values for both arrays
int32_t *p datal = &datal[e];
int32 t *p data2 = &data2[e];
R_GPT@->GTCR = @; // Stop timer
R_GPT@->GTCNT = @; // Clear counter
R_GPT@-»>GTCR = 1; // Start timer
A/5ine calculating 4 outputs at g time, the loop will be 32/4 = 8 (LOOP NO )
for (i = @; i<LOOP_NO; i++)

1
//load 4 data from the array
vectorl = wvldlg_s32(p_datal);
vector2 = wvldlg s32(p data2);

SMultiply (vector2¥*scalarval), add vectorl and store the results
result[i] = wmlag_n_s32(vectorl, vector2, scalarval);

//Increase pointers

p_datal += 4;

p_data2 += 4;

//Get the timer counter
ts_cycle = R_GPT@->GTCNT;

//End placing functions in section .itcm data
ftpragma default function_ attributes =
#endif

Figure 28. Example of Placing a Function in ITCM Section in IAR EWARM Project

You can confirm code placement using the .map file generated by the compiler or using the Disassembly
Window on the debugger.
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Disassembly

PPitem_func_1:

0z32 | O=xed20 0xlf00 WVSTEW. 32 Q0. [RO]

036 | O=ed92 O0xlf00 WLDEW. 32 Q0. [RZ2]

Oz3a:| O=zedie 0xlf00 WVSTEW. 32 Q0. [Re]

Ox3e:| Oxed97 O0xlf00 WVLDEW 32 Q0. [R7?]

0z42 | O=ed90 0x3f00 VLDEW. 32 Q1. [RO]

Nxd6:| Oxee?l O0x2e45 WHMLA S32 Q1. Q0. RS

Ozda:| O=xed2d 0=x3f00 VSTEW. 32 Q1. [R4]

Nzde:| 0=3110 ADDS El., R1. #1a

0=S0:) 0=3210 ADDS REZ, R2, #1l6

0=52:| 0=3410 ADDS E4, R4, #1a

Ox54 | Oxf00f OmcE8lS LE LE, ?Yitcm func 1

0=58 | O=69d8 LDE RO, [R3. #0=lc]

OmSa:| O=d4904 LIE.H El, [PC, #0=x10]

0x5c:| O=c008 STR RO. [R1]

0xSe:| Oxbdf0 POP {R4-R7. PC}
TPitem_func_0:

Q60| 0=d4032"'202c DC3z Oxd032'202c

Oz64:| 0=2200'0000 DC32 wvectorl

Omx6d | O=2200'0120 DC3z2 result

Ox6c:| Ox2200'01f4 DC32 t= cvcle

ITCH_DATASSLimit
0x70: ——— —
ITCH_DATASSLimit

Figure 29. Function Placed in ITCM Section Shown on Debugger

4.5 Improve Performance by Utilizing Data Cache

When a function utilizes long loops, it executes the same code repeatedly. Furthermore, in many
applications, data access may be repeated and sequential. Performance in these scenarios can improve
significantly with cache enabled.

In FSP, the instruction cache enable is done in a function named SystemInit in system.c, as shown in
Figure 30 and Figure 31.

i R R R S i ittt i

* Macro definitions
L

/¥ Mask to select CP bits( OxFogeeo ) */

#define CP_MASK (BxFU << 28)
= = = egiction and LOB extension ¥/
#define CCR_CACHE_EMABLE { ex@@RER201)

¥

/% Value to write to 0AD register of MPU stack monitor to enable MMI when a stack overflow is detected. */
#define BSP_STACK POINTER_MONITOR NMI_ON_DETECTION {(BxASBaU)

Figure 30. Macro Definition to Enable Cache in system.c in FSP
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B e e T e

* Initiglize the MCU and the runtime environment.
R R i ety

void SystemInit (wvoid)

{
#if defined(RENESAS CORTEX_M85)

/* Enable the ARM core instruction cache, branch prediction and Lew-overhead-branch extension.
FcesSection Bt ok the Loptex MSS TRM and Section D1.2.9 in the ARMvB-M Architecture Reference Manual */

| scB->CCR = (uint32 t) CCR_CACHE ENABLE;

__DSB();
—1s8();
#endif

/* Enable the ARM core instruction cache, branch prediction and low-overhead-branch extension.
* See Section 5.5 of the Cortex-M55 TRM and Section D1.2.9 in the ARMvB-M Architecture Reference Manual */
SCB->CCR = (uint32.t) CCR_CACHE ENABLE;

Figure 31. Code to Enable Instruction Cache in FSP

The application projects have a setting to enable data cache. Set the _DCACHE_ENABLE_ symbol in the
project option to 1 to enable data cache. Even though data cache improves performance, it can cause
concurrency and coherency issues. It is good practice to enable the cache for application code that has
repeated access to the same set of data.

Options for node "HEL | A_EK_RA, X
Eeizeen; Factory Settings
General Options [ kuiti-file Carmpilation
Static Analysis Digeard Unugzed Publics
Runtime Checking

C/C++ Compiler Language 1 Language 2 Code Optimizations Outpt
Assembler List Preprocessor Diagnostics Encodings Extra Options
Qutput Converter
Custom Build ] lgnore standard include directories
Lin_kEr _ Additional include directories: (one per ling)
Build Actions $PROJ_DIRS/ra/amm/CMSIS_5/CMSIS/Core/Include ~
Debugger SPROJ_DIRS/ra/fsp/inc
Simulator EPROJ_DIRS/rafspsinc/api
CADI &PROJ_DIRSraf=p/ inc/instances
CMSIS DAP SPROJ_DIRS/ra_cfa/fsp_cfg W
E2/EZ Lite Preinclude file:
GDE Server |
Ijet
Jink/1-Trace Defined symbols: {one per line) .
T1 Stellaris _COMNFIG_HELIUM_=1 [] Preprocessor output to file
Nu-Link Preserve comments
PE micra I_DCP'-CHE_ENP'-B LE =1 Generate Hine directives
ST-LIMK —
Third-Party Driver
TI MSP-FET
TIXDS
] Cancel
Figure 32. Example of Data Cache Enable in Application Project
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Example code to enable and disable data cache are shown in Figure 33 and Figure 34.

#if (_DCACHE ENABLE_ == DCACHE_ENABLE_YES)
SCB_EnableDCache(); //Enable DCache
#endif

Figure 33. Example Code to Enable DCACHE

#if ( DCACHE_ENABLE == DCACHE ENABLE_YES)
SCB DisableDCache(); // Disable Dcache
#endif

Figure 34. Example Code to Disable DCACHE

Another method to enable data cache is using FSP Configurator: BSP > Properties > Settings > MCU
(RA8M1) Family > Cache settings > Data cache, as shown in Figure 35.

5ummar}r|ESP| Clocks | Pins | Interrupts | Event Links | Stacks | Components

4
i
0

& Properties [ Problems
EK-RABM1

Settings  Froperty Value &
s R7TFABMIAHECED
part_nurmber RYFASMIAHECED
rom_size_bytes 2064384
rarn_size_bytes 917504
data_flash_size_bytes 12288
package_style BGA
package_pins 224
s RABMI
SEMIES a
w RABMIT Family
Security
OF50 register settings
OF51_5EL register settings
OF51 register settings
OF52 register settings
Block Protection Settings (BPS)
Permanent Block Protection Settings (PBPS)
First Stage Bootloader (FSBL)
Clocks
w (Cache settings
Data cache Disabled W
Dual Bank Mode Enabled

Main Qscillator Wait Time Disabled ...

w R4 Common

Figure 35. Example of Data Cache Enable using FSP Configurator
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4.6 Using General Purpose (GPT) Timer for Benchmarking
In the projects, GPTO timer is used to measure time for performance benchmarking.
//Clear and start timer for benchmarking
R_BSP_MODULE_GTART(FSP_IP_GPT, €1;
R_GPTB-»GTCNT = @; // Clear counter
R_GPT@->GTCR = 1; // Start timer
#if (_CONFIG_HELIUM_ == I32_SCALAR)
A/Perform scalar calculation (Equivalent with the multiply gccumulate instruction)
for (i = @; i<DAT BUF_SIZE; i++)
datal[i] += (data2[i] * scalarval);
f/Get the timer counter
ts_cycle = R_GPT@-»GTCNT; ;
#elif (_CONFIG HELTIUM == I32 HELIUM) || (_CONFIG_HELIUM_ == I32 HELTUM DTCM) || (_CONFIG_HELTUM == I32 HELIUM_ITCM)
#if (_CONFIG_HELTUM == T32 HELIUM) || (_CONFIG_HELTUM_ == I32 HELIUM_DTCM)
//5ine calculating 4 outputs at a time, the Loop will be 32/4 = 8 (LOOP_NO )
for (i = @; i<LOOP_NO; i++)
//load 4 data from the array
vectorl = vldlg_s32(p datal);
vector2 = vldlg_s32(p data2);
Sultiply (vector2¥scalarval), add vectorl and store the results
result[i] = wmlagq_n_s32(vectorl, wector2, scalarval);
S/Increase pointers
p_datal += 4;
p_data? += 4;
}
//Get the timer counter
|ts_cycle = R GPT@->GTCNT; |
Figure 36. Example of the Timer Code for Benchmarking
5. Verify the Project
5.1 Open Project Workspace
The software tools required to run the application projects are as follows:
¢ |AR Embedded Workbench (IAR EWARM) version 9.40.1.63915 or later
e Renesas Flexible Software Package (FSP) v5.0.0 or later
e SEGGER RTT Viewer v7.92j or later
From IAR EWARM, open the HELIUM_EK_RA8M1.eww.
e Open Workspace
4 « (C) PC10 » HELIUM_EK_RAZM1 v | D 0 Search HELIUM_EK_RAZM1
Organize « Mew folder ==~ [ @
;2" Mame B
= common
&l HELIUM_DOT_PRODUCT_EK_RAZBM1
+ HELIUM_VMLA_EK_RABM1
h HELIUM_VMLADAVA_EK_RAZBM1
= settings
B FQHELIUM_EK_RABMLW |
- WL >
Filename:|HELIUM_EK_RASM1.EWW V| Workspace Files (*.eww) ~
Open |v Cancel
Figure 37. HELIUM_EK_RA8M1.eww Workspace
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The HELIUM_EK_RA8M1 workspace consists of three projects named HELIUM_VMLA EK RA8M1,
HELIUM_VMLADAVA_EK_RA8M1 and HELIUM_DOT_PRODUCT_EK_RA8M1.

Three projects that appear on the workspace when it opens, as shown in Figure 38.

9 HELIUM_EK_RAZM1I - IAR Embedded Workbench IDE - Arm 9.40.1
File Edit View Project J-Link Tools Window Help

D0 R = RO ODC 5. < Q>

Workspace v o X

|HELIUM_DDT_F‘HDDUCT_EK_HABM'I -132_HELIUM_DTCM v|
Files o
SN | HELIUM_EK_Pufhdl ]
@ HELIUM_DOT_PRODUCT_EK_RA8M1 - 132_HELIUM_DTCM * L4
@ HELIUM_VhALA_EK_RABMI - 132_SCALAR o
@ HELIUM_vhALADANA_EK_RABKMT - 132_SCALAR '

Overview HELIUM_DOT_PRODUCT_EK,_RASM1 HELILM_WMLA_EF._Ragk1 i
Debug Log
Figure 38. Projects are Opened in IAR EWARM

To enable data cache support in the application project, change  DCACHE_ENABLE_ symbols in Options >

Preprocessor from 0 to 1, as shown in Figure 39.

Category: Factary Settings
General Options [ Multi-file Carnpilation
Static Analysis Dizcard Urnuzed Publics
Runtime Checdking
CJC++ Compiler Language 1 Language 2 Code Optimizations Output
Assembler List Preprocessor Diagnostics Encodings Extra Options
Qutput Converter
Custom Build [ lgnore standard include directories
Lin_ker ) Additional include directories: jone per line)
Buid Actions SPROJ_DIRS/ra/am/CMSIS_5/CMSIS/Core/Include ~
Debuager SPROJ_DIRS/rafsp/inc
Simulator SPROJ_DIRS/rafsp/inc/api
CADI EPROJ_DIRS/ra/fsp/inc/instances
CMSIS DAP SPROJ_DIRS/ra_cfgAsp_cfa W
E2/E2 Lite Preinclude file:
GDE Server |
I§et
Hink/1-Trace Defined symbals: (one per ling)
TI Stellaris _CONFIG_HELIUM_=1 [ Preprocessor output ta file
Mu-Link e e Preserve comments
FE micro I. DCACHE ENABLE =1 Generate Hine directives
STLINK —
Third-Party Driver
TI MSP-FET
TI¥DS

0k Cancel

Figure 39.

Enable Data Cache Support in Project
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5.2 Build Project

There are several configurations in each project. Select a project, then a project configuration you wish to run

before going to the next step.

File Edit Wiew Project

A I S - =

9 HELIUM_EK_RABM1 - AR Embedded Warkbench IDE - Arm 9.40.1
J-link  Tools

Window Help

“ Ll o2

Workspace

- 0 X

132_HELIUM_DTCM

132_HELIUM
132_HELIUM_DTCM
132_HELILIM_ITCH

W SEGGER_F T
F— B buildinfo.ipct
B Output

HELIUM_DOT_FPRODUCT_EK_RASM1

HELIUM_VMLA_EK_RBABM1 HELIUM Wk « |+

Figure 40.

Cortex-M85 Configuration Control Register (CCR)

On IAR EWARM, launch RA Smart Configurator from Tools > RA Smart Configurator, and click “Generate

Project Content” to generate project content.

Summary

Project Summary

Board:
Device:

FSP Version:
Project Type:
Location:

EK-RABM1
R7FABM1AHECBD
500

Flat

Selected software components

Board support package for RASM1

I/O Port

Arm CMSIS Version 5 - Core (M)
Arm DSP Library Source
RABM1-EK Board Support Files

9D

Support =

Board support package for RTFASM1AHECBD

Board support package for RABM1 - FSP Data
Board Support Package Common Files

45 [HELIUM_DOT_PRODUCT EK_RABM1] FSP Configuration = g

Q

Generate Project Content

RENESAS

C:/Review/HELIUM_EK_RABMY/HELIUM_DOT PRODUCT EK_RA8BM1

v5.0.0
v5.0.0
v5.0.0
v5.0.0
vh.0.0
v5.9.0+renesas.0.fsp.5.0.0
v5.9.0+renesas.0.fsp.5.0.0
v5.0.0

Summaryl BSP| Clocksl Pinsl |r1terrupts| Event Links| Stacks| Componentsl

Figure 41.

Example of Generating Project Content

Build the active project by selecting Project > Make or Project > Rebuild All .
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@ HELIUM_EK_RASM1 - AR Embedded Workbench IDE - Arm 9.40.1
File Edit View | Project | J-link Tools Window Help

it 0 @@ | (e AddFies.. e Qoo

Waorkspace [e Add Group.. - QX
Import File List...

132_HELIUM_DTCH | L Impert File Lis -
Add Project Connection...

Files Edit Configurations... o

F JHELIUM_V ||

Bl Flex Safty % Remove
i SEGGEF

l_ E buildinfo. D Create New Project...
B Qutput | Add Existing Project...

& oOptions... Alt=F7
Version Control System 3

0O Make F7

B compile Ctrl+F7

@ Rebuild Al

& | Clean

& Batch build... 8

Figure 42. Build the Active Project

5.3 Download and Run Project

The EK-RA8M1 kit has a few switch settings that must be configured before running the projects associated
with this application note. These switches must be returned to the default settings per the EK-RA8M1 user
manual. In addition to these switch settings, the board also contains a USB debug port and connectors to
access the J-Link® programming interface.

Table 1. Switch Settings for EK-RA8M1

Switch Setting
J8 Jumper on pins 1-2
J9 Open

Connect J10 on EK-RA8M1 kit to USB port on your PC, open and start SEGGER RTT Viewer with the
following settings.

Connection to J-Link
®) UsE [] serial Mo

QO Tepap
() Existing Session
Specify Target Device
IlR?‘FABMlAH v||

|:| Force go on connect
Script file (optional)

Target Interface & Speed
SWD * | 40000 kHz -

RTT Control Block
() Buto Detection () Address (®) Search Range

Enter one or more address range(s) the RTT Control block can be loc
Syntax: <RangeStart [Hex] > <RangeSize=[, <Range15tart [Hex] >
Example: 0x10000000 0x 1000, 0x2000000 0x 1000

| 022000000 0x2000 |

Cancel

Figure 43. SEGGER RTT Viewer
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Click Download and Debug to start running the project.
@ HELIUM_EK_RABMT - 1AR Embedded Workbench IDE - Arm 9.40.1
File Edit WView Project J-Link Tools Window Help
DR = LD - <Q>%<B>00 RO =[O Ji&t
Workspace v 1 X in.c in.c  hal_entry.
B hmalln t main =R o Download and Debug (Cirl+D)
132_HELIUM_DTCM e &L= ry[l Download the application and start
- #endif //(_CONFIG HELIUM == I32 HELIUM) || (_l the debugger )
Files &+
EL JHELIUM_VMLA_EK_RA8M1 -132_HELIUM_DTCM #if (_CONFIG_HELIUM == I32 HELIUM ITCM)
B Flex Software APP_PRINT ("\r\VMLA-nHelium Operation on RABM1 with ITCM Utilized\r\n™);
_ #endif //(_CONFIG HELIUM == I32 HELIUM ITCM)
-SEGGER_R-H— #endif //(_CONFIG HELIUM == I32 HELIUM) [[| (_CONFIG HELIW == I32 HELIUM DTCM)
I— El buildinfo.ipct - - - - corh = - - - - !
B Output //clear and start timer for benchmarking
R_BSP_MODULE_START(FSP_IP_GPT, @);
R_GPT@->GTCNT = @; // Clear counter
R_GPT@->GTCR = 1; // Start timer

Figure 44. Start Running the Project
The operation results will be printed on SEGGER RTT Viewer, as shown in Figure 45

All Terminals Terminal 0 Terminal 1 Terminal 2 Terminal &

A-Helium Operation on RABML with DTCM Utilized
Timer counter cycle: 144

sult[@]:

2|

Figure 45. A Helium Operation with DTCM Utilized
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5.4 Confirm Instructions Generated For Helium™ Extension

Use the Disassembly window of EWARM to check the Helium™ extension code generated by IAR EWARM
compiler.

Figure 46 shows the disassembly of scalar code.

H_] ﬂEr (i = @; i<DAT_BUF_SIZE; i++) Disassembly
[ |_| for (i = 0. i<DAT BUF_SIZE. i++)

= } 02000696 Ox4c23 LDR H R4, ?7?DataTabled_3.
//Get the timer counter 0=200'0698: O=f04f 0=0=08 MOV .W 1R, #8
ts_cycle = R_GPTO->GTCNT;; 0=200'069c: O=4621 HOV R1, R4

#elif (_CONFIG_HELTUM == T32 HELTUM) || (_CONFIG_HELTUM AN et DeESld G-2eE AT Ro. R4, #128

B #if (_CONFIG HELIUM_ == I32 HELIUM) || (_CONFIG HELIUM T=200°0622: U=20ds U=l LIS o2, 03
//Sine calculating 4 outputs at a time, the Loop wil datal[i] += (data2[i] * scalarval):
for (i = @; i<LOOP_NO; i++) ??hal entry 0:

=] { 0=200'06ab: O=f352 0x5b04 LDR.W RS, [R2]. #0=4

//Load 4 data from the array 0=200'06aa: O=&&0hb LDR R3, [R1]
vectorl = vldlq s32(p_datal); 0x200'06ac: Oxeb03 0x0345 ADD.W R3., R3. R5. LSL #1
vector2 = vldlg_s32(p_data); 0200 06b0: 0z600b STR R3, [R1]
/’/’-"'JUL'L"LEL}" (vector2*scalarval ), add vectorl and st Betemil[4] <= (Eoiad[i] = scmlewwad):
result[i] = wvmlag_n_s32(vectorl, vector2, scalarva -
//Increase pointers
p_datal += 4; 0=200'06h6: O=6E4b LDR R3. [R1. #0x4]
p_data2 += 4; 0x200'06b8: O=sb03 0x0345 ADD.W R3. R3. RS, LSL #1
= } 0=200'06bs: O=604b STR R3. [R1. #0=4]
//Get the timer counter datal[i] += {data2[i] * scalarvall:
ts_cycle = R_GPT@->GTCNT; 0x200'06be: 0=f852 0=z5h04 LDR.W RS, [R2]. #0=4

- #endif Dx200'06c2: 02688b LDR B3, [Rl. #0x8]

Bl #if (_CONFIG_HELTUM_ — 132 HELIUM_ITCH) 02200'06cd: Oxsb03 0z0345 ADD.W R3, R3, RS, LSL #1
//Fuction placed in ITCM section 0=200'06=8: O=e08b STR R3. [R1. #0=8]
item func(); datal[i] += (data2[i] * =calarwval):

| #endif //(_CONFIG_HELIUM == I32 HELIUM ITCH) 0=200'06ca: O=xf#52 0x5h04 LDR.W RS, [R2]. #0=4

0x200'06ce: D=b8ch LLE R3. [R1. #0=zc]

- #endif //(_CONFIG_HELIUM == I32 HELIUM) [[ (_CONFIG_HEL 0=200°'06d0: Oxeb03 0x0345 ADD.W R3, R3, RS, LSL #1
R_GPTO->GTCR = 0 //Stop timer 0=200'06d4 . O=6lch STR B3, [RF1, #0uc]
= A for (i = 0: i<DAT BUF_SIZE: i++)

S/Print timer cycles

0x200'06d6: 0=x3110 ADDS k1. El. #16

APP_PRINT("Timer counter cycle: %d \n", ts_cycle);

Figure 46. Disassembly Code of Scalar Code

Figure 47 shows the disassembly of Helium code generated using the Helium™ extension.

J] ;’;’Siﬁ?' cm‘.cm:.atf.ng 4 ou?puts at a time, the Loop wil Disassembl
for (i = @; i<LOOP_NO; i++) Y
= { for (i = 0; i<LOOF_NO: i++)
//Load 4 daota from the array 0=200'06ac: Oxdc3d LDR. N R4, ?7DataTableld_4.
L vectorl = vldig_s32(p_datal); 0x200°' D6ae: 0=2201 HOVS R2, #1
vectorz = vidiasiapdataz); ) 0x200'06b0: Oxf04f Ox0=02 HOV.W IR, #8
S/Multiply (vector2*scalarval), add vecterl and st 0=200' 06h4 © Oxh00Z =TR RZ, [RO]

result[i] = vmlag_n_s32(vectorl, vector2, scalarva

//Increase pointers 0x200'06b6: 0O=xfl104 O0x0120 ADD. W El, R4, #32
o datal +- 45 0200 06ba: Oxflds Oxe01 DIS IR, IR
p data2 += 4; 0x200'06be: Ox2202 HOVS k2. #2
- 13 g 0x200'06c0: 0Oxf104 0x0310 ADD. W RE3. R4, #le
//Get the timer counter 0x200'06cd: Oxf104 0=0710 ADD.W R7. R4, #lc
ts_cycle = R_GPT@->GTCNT; E wectorl = vldlg =32(p _datal):
[ #endif 1 ?7hal entry 0
B #if (_CONFIG_HELIUM_ == I32_HELIUM ITCM)
J7Fuction placed in ITCH section 0x200°' DEce: Oxed84 0=li00 VSTRW.32 Q0, [R4]
item func(); wector? = wldlg =32(p_data2):
L gendif /7( CONFIG HELIUM == I32 HELIUM ITCH) 0x200°'06d0: Ox=d96 0x1f00 VIDRW.32 00, [R6]
0x200'06d4: 0O=xedB83 0x1f00 VSTEW.32 Q0, [R3]
[ #endif //(_CONFIG HELIUM == I32 HELIUM) [[ (_CONFIG_HEL result[1i] = wmlag n =32({vectorl, wvector?, scalarwval) ]
L, . 0x200'06d8: Oxed97 0x1f00 VIDRW.32 Q0. [R7]
;'E;ﬁjﬁ:ii::cié,é’sStW timer 0x200'06de: Oxed94 Ox3£00 VIDRW.22 QL. [R4]
APP_PRINT("Timer counter cycle: %d \n", ts_cycle); 0x200'06e0: Oxee2l 0Ox2ed42 VHMLA S32 (1, Q0. R2
0x200'06=d4: OxedBl 0=3f00 WSTRW.32 Q1. [R1l]
Bl #if (_CONFIG HELIUM == I32 SCALAR) p datal += 4;
J/Printing the results 0x200'06=8: 0x3510 ADDS E5. E5. #16
for(i=0; i<DAT_BUF_SIZE; i++) o data? += 4;
=] £ o S U200 U6==: 0=3610 005 RE. Re. #16
Figure 47. Disassembly of Helium Code Generated by IAR WARM
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5.5 Benchmarking Performance

Use the “Timer counter cycle” printed on SEGGER RTT Viewer for performance benchmarking. It shows how
many GPTO counter cycles have elapsed since the function was executed.

All Terminals Terminal O Terminal 1 Terminal 2 Terminal &

VMLA-Helium Operation on RABM1 with DTCM Utilized
Timer counter cycle: 144
result|®]: b4

result[2]: 7

result[1]: &7
> result[3]: 73

Figure 48. Example of Timer Counter Cycle on RTT Viewer

5.5.1 VMLAVADA Project HELIUM_VMLADAVA_EK_RA8M1
The performances of the function vmladavaq_s32 in various configurations are as follows.

Project Configuration Timer cycle |Performance Increase (vs 132_SCALAR) %
132_SCALAR 386

122_HELIUM 222 42.5
132_HELIUM_DTCM 148 61.7
132_HELIUM_ITCM 213 43.5

Figure 49. Performance Data w/o Data Cache Enable

Performance w/o Data Cache enable

132_HELIUM _ITCM
132_HELIUM _DTCM
32_HELIUM

32_SCALAR

‘[’f

=]

50 100 150 200 250 300 350 400 450

B Performance Increase (ws 132_SCALAR) % W Timer cycle

Figure 50. Performance Chart w/o Data Cache Enable
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Following are the performances of the vmlaq_n_s32 function with data cache enabled in various
configurations. To enable data cache in the project, follows steps in section 4.5, build and download it .

Project Configuration Timer cycle |Performance Increase (vs 132 SCALAR) %
132_SCALAR (w/o data cache enable) 386

122_SCALAR 82 78.8
122_HELIUM 58 85.0
132_HELIUM_DTCM 60 84.5
122_HELIUM_ITCM 52 86.5

Figure 51. Performance Data w/ Data Cache Enable

Performance w/ Data Cache enable

32_HELIUM_ITCM
132_HELIUM_DTCM

132_HELIUM

132_5CALAR

32 _SCALAR (wfo data cache enable)

=]

100 200 300 400 500

B Performance Increase [vs 132_SCALAR) % B Timer cycle

Figure 52. Performance Chart w/ Data Cache Enable

5.5.2 VMLA Project HELIUM_VMLA_EK_RA8M1
The performances of the function vmlaq_n_s32 in various configurations are as follows.

Project Configuration Timer cycle |Performance Increase (vs 132_SCALAR) %
132_SCALAR 263

132_HELIUM 218 17.1
132 HELIUM_DTCM 144 45.2
132_HELIUM _ITCM 217 17.5

Figure 53. Performance Data w/o Data Cache Enable
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Performance w/o Data Cache enabled

132_HELIUM_ITCIM
132_HELIUM_DTCM
132_HELIUM

132_SCALAR

[

[=]

30 100 150 200 250 300

W Performance Increase (vs 132_SCALAR) % B Timer cycle

Figure 54. Performance Chart w/o Data Cache Enable

Below are the performances of the vmladavaq_s32 function with data cache enabled in various
configurations. To enable data cache in the project, follows steps in section 4.5, build and download it .

Project Configuration Timer cycle |Performance Increase (vs 132 SCALAR) %
132_SCALAR (w/o data cache enabled) 263

132_SCALAR 52 80.2
1322_HELIUM 58 77.9
132_HELIUM_DTCM 57 78.3
132 _HELIUM _ITCM 52 80.2

Figure 55. Performance Data w/ Data Cache Enable

Performance w/ Data Cache enable

132_HELIUM_ITCM

132_HELIUM _DTCM

132_HELIUM

132_SCALAR

132_SCALAR (w/o data cache enabled)

=
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M Performance Increase (vs [132_SCALAR) % W Timer cycle

Figure 56. Performance Chart w/ Data Cache Enable
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5.5.3 DSP Dot Product Project HELIUM_DOT_PRODUCT_EK_RA8SM1

The performances of the ARM DSP Dot Product arm_dot_prod_f32 function in various configurations are as
follows.

Project Configuration Timer cycle |Performance Increase (vs 132_SCALAR) %
132_SCALAR 270

132_HELIUM 158 41.5
132_HELIUM_DTCM 100 63.0

Figure 57. Performance Data w/o Data Cache Enable

Performance wjo Data Cache enable

132_HELIUM_DTCM

132_HELIUM

132_SCALAR

!
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Figure 58. Performance Chart w/o Data Cache Enable

Below are the performances of the ARM Dot Product arm_dot_prod_f32 function with data cache enabled in
various configurations. To enable data cache in the project, follows steps in section 4.5, build and download
it .

Project Configuration Timer cycle |Performance Increase (vs 132_SCALAR) %
132_SCALAR (w/o data cache enable) 270

132_SCALAR 439 81.9
132_HELIUM 36 B86.7
122_HELIUM_DTCM 21 92.2

Figure 59. Performance Data w/ Data Cache Enable
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Performance w/ Data Cache enable

132_HELIUM _DTCM

132_HELIUM

132_SCALAR

132_SCALAR (w0 data cache enable)
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Figure 60. Performance Chart w/ Data Cache Enable

6. Conclusion

The Renesas RA8 MCU with Arm Cortex-M85 supports significant scalar performance uplift. Furthermore,
the Tightly Coupled Memory (TCM) support in Renesas FSP makes it easier to utilize Helium intrinsics and
TCM for further improvement.
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Website and Support

Visit the following vanity URLSs to learn about key elements of the RA family, download components and
related documentation, and get support.

RA Product Information renesas.com/ra

RA Product Support Forum renesas.com/ra/forum

RA Flexible Software Package renesas.com/FSP

Renesas Support renesas.com/support
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10.

1.

12.

13.
14.

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your
product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use
of these circuits, software, or information.
Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights,
or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics
or others.
You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export,
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.
You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for
each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics
disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product
that is inconsistent with any Renesas Electronics data sheet, user's manual or other Renesas Electronics document.
No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but
not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE,
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO
THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.
When using Renesas Electronics products, refer to the latest product information (data sheets, user’'s manuals, application notes, “General Notes for
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas
Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such
specified ranges.
Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics
products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily
injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as
safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for
aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are
responsible for evaluating the safety of the final products or systems manufactured by you.
Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.
Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.
It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.
This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.
Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas
Electronics products.

(Note1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled

subsidiaries.

(Note2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

(Rev.5.0-1 October 2020)

Corporate Headquarters Contact information

TOYOSU FORESIA, 3-2-24 Toyosu, For further information on a product, technology, the most up-to-date
Koto-ku, Tokyo 135-0061, Japan version of a document, or your nearest sales office, please visit:
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